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· Welcome to Album

The ImagePals Album program will help
you organize and manage all the files in your
system – be they image, graphics, video,
animation or other document files. Once linked
to an album, you can view your files as filenames,
like Windows File Manager, or display a
thumbnail of each. Complementing Album’s
management features are the two programs: CD
Browser and Viewer. Working together, they
allow you to view, manage and edit data from all
types of media devices.
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How to get the most from the programs

Reading this guide is not the only way you can learn

about Album, CD Browser and Viewer: the introductory guide

provides useful background information that will help you work

more efficiently while the ReadMe file contains technical

information and anything that came to light after this manual

was produced. Lastly, the on-line help provides the most

complete and in-depth reference to either program. You can

access help from a program by pressing the F1 key or clicking on

the help button provided in certain dialog boxes.

The first six chapters of this guide are concerned with Album,

the last two, with CD Browser and Viewer respectively. The

following provides a brief preview of the contents of each of

these chapters:

1. Getting started, introduces the Album program window and
provides a reference to each program’s menu commands.

2. Album basics, describes basic Album functions such as applying
commands, drag-and-drop operations and customizing Album.

3. Managing albums, explains how to create albums and perform
standard album file maintenance such as copying, moving,
archiving and restoring album files.

4. Managing thumbnails, shows you how to insert thumbnails of
files into albums as well as manage the files on your system.

5. Labeling thumbnails, explains how to assign keywords, marks,
subjects and descriptions to thumbnails.

6. Locating thumbnails, takes a look at performing a variety of
search operations to locate thumbnails and the files of
thumbnails.

7. CD Browser, introduces the CD Browser program of ImagePals.

8. Viewer, introduces the Viewer program of ImagePals.

• Index
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1 Getting Started

This chapter explains how to run Album and
introduces the Album program window. After the
introductory section there is a brief explanation
of the menus, as well as tables referencing where
in this guide you will find descriptions about the
menu commands for Album, CD Browser and
Viewer.
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1·1
Running the programs

To run Album, you first need to locate the appropriate program

icon. If you followed the suggestions made by the installation

program, the Album icon will appear in the ImagePals program

group.

The ImagePals
program group

Run Album by double-clicking on the Album icon. The program

window appears containing the product information box.

(Clicking anywhere within the program window removes this

box and enables Album.)

1.1.1 The Album window

When you invoke Album you may see:

• Albums within the workspace (the central portion) of the Album
window.

• A ribbon, below the menu bar, providing quick access to search
functions. (Double-clicking on an empty portion of the ribbon
opens the Search dialog box.)

• The mark palette, on the left, used to identify and label
thumbnails and a toolbox, on the right, providing direct access
to your programs as well as a “shelf” to store albums.

• The status bar, at the bottom, displaying information about the
active album. (Double-clicking on the status bar opens the
Album preferences dialog box, see p.25)
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The Album program window
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1·2
The program menus

One of the most common methods of applying operations is to

choose a command from the menu bar. Each of the programs

also provides access to some commands through a ribbon or

menu button on the status bar.

When you view menus, some commands appear in black while

others are grayed-out. (The actual colors depend on your

current Windows color scheme.) Commands in black are active

and available for selection while grayed-out commands are

inactive and unavailable for selection.

Note: A command may be inactive because it is not currently
applicable, e.g. when there are no albums open, the Remove
command in Album is inactive, or when your PC does not have
the necessary hardware to support that particular function.

In each menu, keyboard shortcuts appear to the right of some of

the menu commands. Use shortcuts to perform the

corresponding command from the keyboard – without the need

to access the menu with your mouse. Instead of a shortcut key,

there may be a right-pointing arrow or three dots. The arrow

signifies that a submenu exists for that command while the dots

indicate the command accesses a dialog box. If a command has

neither of these, then its effect is immediate.

1.2.1 Command reference tables

The following tables provide a list of each program’s commands.

In each table, to the right of the command, you will find any

shortcut keys available and the number of the page on which

they are described.
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Album menu Edit menu

Command shortcut p. Command shortcut p.
New... 35 Undo Ctrl + Z 18
Open... Ctrl + O 38 Repeat F4 18
Remove 40

Cut Ctrl + X 56
Update 28

Copy

File

Thumbnail

Filename

Ctrl + C

56

56

56

Batch Manager... 17

Properties... 39

Keywords... 74

Maintenance

Check

Move...

Copy...

Delete

Rename...

Backup...

Restore...

Ctrl + K 41

42

42

43

43

43

45

Paste Ctrl + V 57

Clear Del 59

Select

All

None

Invert

Ctrl + L

Ctrl + N

55

55

55

Make Album 35

Run Enter 19
Acquire... 52

Select Source... 52

Print

Album...

Thumbnails...

Keywords...

File... Ctrl + P

57

58

59

59

Printer Setup... 57

Preferences

Album...

OLE & Clipboard...

Photo CD...

Display...

Memory...

File Formats...

Ctrl + B 25

28

30

31

32

32

Exit Ctrl + Q 100



12 12 ALBUM USER GUIDE

Thumbnail menu File menu

Command shortcut p. Command shortcut p.

Insert... Ins 50 Convert File Format... 67

Properties... Alt + Enter 83 Convert Data Type... 68

Move... 99 Move... 68

Search Ctrl + S 94 Copy... 69

Search by Item

Keywords...

Subjects...

Marks...

95

96

96

Delete 69

Rename... 70

Attributes... 70

Associate... 71
Search by Query 96

Search Entire Album Ctrl + W 93

Sort by

Name

File Type

Size

Date

Media Type

Subject

Description

Others...

User Defined

Ctrl + F1

Ctrl + F2

Ctrl + F3

Ctrl + F5

Ctrl + U

98

98

98

98

98

98

99

99

99

View menu

Command shortcut p.

All

Invert

Ctrl + A 55

55

Selected 55

Scroll To... Ctrl + D 62

Auto Scroll... 62

Thumbnails Ctrl + T 61

Filenames Ctrl + F 61
Save Sequence 99

Slide Show... 63
Update

From File

From Clipboard

53

54

File 64

File Information... 65

Album Information... 65Relink... 72
Options

Shelf...

Hide Toolbox

Hide Mark Palette

Hide Search Ribbon

66

66

66

66
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Window menu Viewer
Command shortcut p. File menu
Cascade Shift + F5 39

Command shortcut p.Tile Shift + F4 39

Open... Ctrl + O 112Arrange Icons 39

Reopen 114

Save As... 114

Close All 117Toolbox menu
Minimize All 117

Restore All 117Command shortcut p.
Run Image Editor Ctrl + G 114New... 20
Run Other Editor 114Delete... 21
Preferences

Viewer...

Photo CD...

Display...

Memory...

File Formats..

119

30

31

32

32

Properties... 20

Groups 21

Configure... 22

Run... Ctrl + R 19

Close 66

Exit Ctrl + Q 120

Mark palette menu

Command shortcut p.

Move 77

Close 66

Assign Selected 81

Clear Selected 81

Clear All 81

Edit... 81

Load... 81

Save... 81

Convert to Keywords... 82
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Edit menu CD Browser
Command shortcut p. File menu
Copy Ctrl + C 114

Command shortcut p.Copy Filename 114

Load Photo CD Disc Ctrl + P 102Crop Ctrl + R 114

Run Image Editor Ctrl + G 105Select None Ctrl + N 114
Insert Thumbnails to Album Ctrl + I 106

Save As... Ctrl + A 108

Select All Ctrl + L 104View menu
Select None Ctrl + N 104

Select Invert 104
Command shortcut p.

Preferences... 109
Actual View Ctrl + A 115

Exit Ctrl + Q 110Zoom In + 115

Zoom Out - 115

Fit in Window 116
View menuFull Screen Ctrl + W 116

Information... Ctrl + I 116

Command shortcut p.Place Viewers on Top Ctrl + B 117

Run Viewer Enter 107Cascade Viewers Ctrl + S 118

Disc Information... 107Tile Viewers Ctrl + T 118

Always on Top 118 Image Information... 107
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2 Album basics

Before beginning work with Album, you first
need to understand some of the basics about how
Album manages the files on your system. This
chapter introduces these basics explaining how
you can access programs from the toolbox,
perform drag-and-drop operations, and use the
Preferences commands to customize the way
Album works with you and your Windows
environment. There are also sections on applying
multiple commands with the batch manager,
using the “repeat” key and recovering from any
mistakes made.
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2.0.1 Album – an overview

The traditional way of managing files has been to use the “file

tree” approach, such as that adopted by DOS and Windows. This

method displays the files on your system as a tree consisting of a

root directory with subdirectory “branches”. Album does not

change this structure, it only represents the information in a

different way – through the use of albums and thumbnails.

Albums, just like the real thing, are used to store photographs

(thumbnails) of your files. Just as you can have albums of

photographs for particular events, you can have albums of files

for particular purposes, e.g. an album of video files, or one that

holds your latest multimedia presentation.

Thumbnails are visual representations of the contents of a file.

Therefore you can “see” what a file is, rather than having to rely

on an 8 character filename. This way, it is much easier to identify

your files and to group like files together. Thumbnails also allow

you to append additional information, such as subjects and

descriptions, that traditional filenames could never do.

An example of
thumbnails in an

album
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2·1
Applying commands

To perform an operation, you first need to select the thumbnail

or album you want the operation to be performed on, and then

choose the appropriate command from a menu. This is fine

when you only want to apply the command to a few thumbnails

within a single album, but proves inefficient when you want to

perform the same command to thumbnails in different albums.

To overcome this limitation, Album provides an extra feature,

the batch manager.

2.1.1 Using the batch manager

The batch manager can be accessed in two ways: double-

clicking on an empty part of the workspace or choosing the

Batch Manager command in the Album menu. Once invoked,

the batch manager opens and displays the titles of all the

albums present in the workspace. The commands that can be

applied in the batch manager are: Check, Minimize, Print

Thumbnails, Put on Shelf, Remove, Restore Window, Save

Sequence, Search, Sort by, View All, View Thumbnails and View

Filenames.

To perform a batch command, choose the command you want

to perform and select the albums you want the command to be

performed on. Once decided, click OK – batch manager does the

rest for you.

Note: The batch manager can only apply commands to albums open in
the workspace. If there are no open albums it is unavailable.
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2.1.2 Repeating commands in Album

Complementing the batch manager is the Repeat command in

the Edit menu. This allows you to perform the last applied

command again by pressing the “F4” key. Simply apply a

command to a thumbnail or album, select another thumbnail or

album and press “F4”. The action is repeated. Most of Album’s

commands can be repeated in this way, for example:

• select a thumbnail and choose “Properties” from the Thumbnail
menu. In the dialog box that appears, enter a description in the
Description entry box and click OK. Select another thumbnail
and press “F4”. The Properties dialog box reopens, enabling you
to quickly add new information to the thumbnail.

• select an open album and choose “Size” from the Thumbnail:
Sort by submenu. The thumbnails in the album are sorted by
their file size. Select another open album and press “F4”. The
images in the second album are sorted in the same manner.

2.1.3 Recovering from mistakes

If you make a mistake while working in Album, you can

normally correct it by using the Undo command in the Edit

menu. This reverses the last applied command and returns the

album and its thumbnails to their state prior to the application

of the command. At times you may see Can’t Undo in the Edit

menu. This is when you cannot undo the last action, e.g.

immediately after deleting the file of a thumbnail.
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2.2
Using the toolbox

Central to Album’s ability to manage files is its ability to act as a

program manager through the toolbox. By adding frequently

used programs into the toolbox you can transfer control and, in

many cases, files between Album and those programs. You can

also place similar programs into program groups, allowing you

to instantly change the toolbox configuration depending on the

task at hand, e.g. one group can consist of your multimedia

programs, another, your word processing programs and so on.

Once an icon is added to the toolbox, simply click on it to open

the corresponding program. (You can also open programs from

the Run dialog box, accessed by choosing the Run command in

the toolbox menu.)

2.2.1 Adding programs to the toolbox

When you invoke Album for the first time, the toolbox appears

with a number of “empty” icons. When you add a program, each

of these icons are replaced with that of the appropriate program

icon. Once placed into the toolbox, you can then manage your

programs, and determine which programs are accessible, and at

what times.
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 To add a program icon:

1. Click on the tools button in the toolbox and choose “New” from
the menu. The New Program dialog box opens.

2. Click on the Program Group option and in the Group Name
entry box enter the name of a group you want the program to be
associated with, e.g. Multimedia.

3. Click on the Program Icon option and enter the Description,
Command Line and Working Directory of the program
concerned. To load the ImagePals Image Editor program, type
in Image Editor for the Description, the full pathname where
your ImagePals files are located for the Command Line and the
full pathname of your temp directory for the Working Directory.

4. Click on the New button. The program icon appears in the
toolbox. If you want to add more programs to the toolbox, repeat
steps 2 to 4.

5. Click on the Close button to close the dialog box.

Notes:

• You can also add programs to the toolbox by dragging
execution files (EXE) from Windows File Manager and dropping
them onto an empty icon in the toolbox.

• To change program groups, choose the appropriate group name
from the list of group commands in the toolbox menu.

• If you wish to change any of the parameters specified in the
New Program dialog box, choose the Properties command in the
toolbox menu.
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2.2.2 Removing a program

At times you may want to remove a program icon; this can be

because you no longer need it, have deleted the program from

your hard disk, or feel that there are too many icons in the

program group. When you remove icons, you can choose to

remove individual ones, or all those associated to a program

group.

To remove a program icon or a program group:

1. Click on the tools button in the toolbox and choose “Delete”.
The Delete dialog box opens.

2. To delete the current program group, select the Delete Current
Program Group option. (This deletes all program icons
associated with that group.) To delete an individual program
icon, select the Delete Program Icon From Current Group
option and highlight the icon to be deleted from the Icon combo
box.

3. Click OK. The selected program icon or group disappears from
the toolbox and the dialog box closes.

2.2.3 Scrolling the program icons

The arrangement of the programs in the toolbox depends upon

the order in which you add them. When a program is added, it

automatically goes to the end of the list. Too many however, and

you may not be able to see them displayed within the program

window. To scroll through the icons, click on the direction

arrows. Clicking on the left arrow scrolls up, clicking on the right

arrow scrolls down. (If all the program icons can be displayed

within the workspace, the direction buttons are disabled.)
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2.2.4 Customizing the toolbox

When you work in Album, you may prefer the toolbox in another

position, or feel that there are not enough program icons

available. To better customize the toolbox, use the Configure

command (accessed by clicking on the tools button) to open the

Configure dialog box. To increase the number of program icons,

enter a value (between 1 and 24) in the Icons to Show entry box.

Checking the Show Names option displays the names of each

program under their respective icon in the toolbox. (You may

find that when selecting this option the toolbox expands in size

to accommodate the added text.) In the Configure dialog box

you can also choose to make the toolbox floating or fix it to the

left or the right of the Album window. When floating, move the

toolbox by dragging on the title bar.

Displaying the
toolbox without the

program icons’
names (toolbox on
the left) and with

(toolbox on the
right)
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2·3
Performing drag-and-drop
operations

Drag-and-drop is a simple, yet powerful technique for

transferring information within and between programs, and

shifting the focus of your work during a Windows session. Album

provides extensive support for drag-and-drop that enhances

Album’s ability to provide complete file and program

management. The following section describes the drag-and-

drop operations you can perform with Album:

2.3.1 Drag-and-drop to the toolbox

One of the more common drag-and-drop operations is to drag a

thumbnail from an album and drop it onto a program icon in

the toolbox. Given that the file is compatible and the program

accepts command line opening of files, the file associated with

the thumbnail is opened in the destination program. Dragging

and dropping to one of the ImagePals program icons (except for

CD Browser) is even more powerful, as you can drag-and-drop

multiple thumbnails in one go.

Note: Double-clicking on thumbnail, pressing the Enter key, or
choosing the Run command in the Edit menu also opens the file
of a thumbnail, as long as it has the correct program association,
(see p.71).

2.3.2 Drag-and-drop to the program workspace

If you have other programs running at the same time, you can

drag-and-drop thumbnails directly into the program’s

workspace rather than its program icon in the toolbox.

(Depending on the settings in the OLE & Clipboard dialog box,

see p.28, this either embeds, links or opens the file, where

compatible.)
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If you are working from Windows File Manager, you can:

• drag-and-drop program files (EXE) to an empty icon in the
toolbox of Album to create program icons.

• drag-and-drop album files (ABM) into the Album workspace to
open them.

• drag-and-drop files into albums to creates thumbnails of the
files.

Notes:

• It is important that files are dragged to the right place, e.g.
albums must be dropped in an empty part of the workspace,
images must be dropped into an album, and programs must be
dropped onto the toolbox.

• When dragging thumbnails to other programs, the result is
determined by the particular program. In general, if you drop a
thumbnail onto a minimized program icon, or onto the program
window’s title bar, the program will attempt to open it. If you
drop the thumbnail into the program’s workspace, it may be
placed into the active document as an object, or it may be
opened; exactly which depends on the settings defined in the
OLE & Clipboard preferences dialog box, (see p.28).

2.3.3 Drag-and-drop thumbnails to albums

With drag-and-drop you can easily move thumbnails within or

between albums by simply selecting the thumbnails and

dragging them to their new destination. (This can be to an open

album or its minimized icon.) Thumbnails moved from one

album to another are removed from the first and introduced at

the end of the second (or in the position determined by the

album’s current sort mode). If you hold the Ctrl key down while

dragging, the thumbnails are copied. (The original files

associated to the thumbnails are not duplicated.)

Note: Thumbnails, when dropped into an album, change to suit the
current size of the thumbnails in the target album.
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2·4
Customizing the way you work

An essential part of Album’s management is that it allows you to

control both the program and how the program interacts with

Windows. This is done through the preferences commands in

the Album: Preferences submenu. The following section

describes each of these commands and details how you can use

them to improve the way Album works for you:

2.4.1 Album

Choosing this command opens the Album dialog box. (Double-

clicking on the status bar also performs the same function.) In

this dialog box you can set various features related to working

with files and thumbnails.

Using the Display Information group box you can change what

information is displayed with each thumbnail or filename. In

thumbnail mode you can choose to display the filename, subject

(if the thumbnail contains a subject), or neither. Checking the

Don’t Show Thumbnail Slide option removes the slide around a

thumbnail and only displays the thumbnail image. This is

helpful when viewing a large number of thumbnails and you

want to have as many as possible displayed in the current view.

In filename mode you can choose to display either file

attributes, keywords, subjects, descriptions or directories of files.
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If you find your albums are using too much disk space, check the

Reduce True Color to 256 Color option. The next time you insert

thumbnails, any True Color thumbnails are automatically

converted to Indexed 256-Color. (This can help reduce

thumbnail size by two-thirds.) This does, however, increase

thumbnail insertion time and results in poorer quality

thumbnails.

Note: Indexed 256-Color thumbnails can only be compressed using
LZW compression (irrespective of the compression option
selected in the Album Properties dialog box, see p.39).

To ensure that thumbnails accurately show the current status of

their associated files, leave the Enable Automatic Checking of

Source Files option checked. Any changes made to a file are

immediately updated in the thumbnail whenever the thumbnail

is selected or the view in the album changes, such as from

scrolling or performing a sort operation. Although this option

doesn’t require any extra memory, it may slow down processing

time. Leave this option unchecked when you are certain files

have not been modified, if it is not necessary to update existing

thumbnails, or if you wish to scroll quickly through an album

without having thumbnails repaint.

Note: If, during a check, Album comes across any missing files, a cross
appears over the index number of the appropriate thumbnail.
You can then choose to reinsert, relink or delete the thumbnail.
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Checking the Minimize on Use option minimizes Album as soon

as you switch to or invoke another program from the toolbox.

The Sort Thumbnails in Ascending Order option rearranges

thumbnails into ascending order whenever a sort command is

applied. Leaving this option unchecked sorts the thumbnails in

descending order.

To free up as much system memory as possible, check the Swap

Out to Disk When Minimized option. The next time you

minimize an album, the system memory used for that album is

released. (This method can help free up to 100 KB for an album

containing 1000 thumbnails.)

Note: When you swap out to disk, the memory contents of the album
are saved to a file in your TEMP directory (*.$$$). Restoring the
album reads that file back into memory. This may slow
processing time depending on the size of this file and the
current state of your system’s resources.

Displaying
thumbnails in an

album with no slide,
filename, and

subject information
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2.4.2 OLE & Clipboard

Choosing this command opens the OLE & Clipboard dialog box

providing options to control the clipboard and how Album

behaves when performing OLE operations. (For background

information on OLE, refer to the introductory guide.)

Note: The default settings you see here are designed to allow Album
to function at an optimum when performing OLE operations or
when working with image and graphics data. In most cases
there will be no need to change these settings. Do so only when
you require greater control over OLE and clipboard processes.

In the Formats to Copy to Clipboard group box, you can specify

if you want Album to act as a server program when performing

OLE operations, as well as defining how image and graphics

data is represented on the clipboard. If you want to perform an

embedding or linking operation, then you must check the

appropriate OLE options, OLE Embedding Format or OLE

Linking Format. If neither is checked, the Paste Special

command in the client program will be disabled. (If both are

checked, you can decide on which option to use when in the

client program.)

The two options, Device Independent Bitmap (DIB) and Device

Dependent Bitmap (DDB) allow you to determine how image

information is recorded when you place image and graphics

files onto the clipboard. If you are on a network and share data,

or want an image to appear at the same size in different

resolutions, or want to maintain the color and resolution

between programs, select the Device Independent Bitmap

option. Checking this option also enables the Convert as

Display Mode option. This converts the data type of an image

(when placed onto the clipboard) to that of your current display

mode, and is particularly useful if you are using a low resolution

display and wish to save on system resources.
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If you work on a stand alone machine, do not share data with

other machines or programs, and work in the same screen

resolution, then check the Device Dependent Bitmap option.

This only records the minimum amount of display information

necessary when using the clipboard. (You may find this option

produces different results for different programs depending on

how the program handles particular data structures.)

Notes: After placing images onto the clipboard, do not change these
options before pasting. Doing so may produce unexpected
results.

When performing OLE operations, you can determine how the

object is represented in the client document by selecting an

option in the OLE Representation Format group box. Checking

the Source Object option displays the entire file in the client

document. This allows you to clearly see the contents and

dimensions of the object file, but does increase the client’s file

size and slow down its operation.

To display image or graphics objects without greatly affecting

the client’s file size or operation, check the Low Resolution

Place Holder option. This places a low resolution version of the

object file into the client document and is particularly helpful

when preparing images for publication, and it is not necessary

to have a good quality image displayed on screen.

Note: When you print the document, the low resolution image is
printed. To print the original file, check the Enable Automatic
Checking of Source Files option in the Album dialog box.

If it is not necessary to display the object, or its dimensions,

check the Thumbnail Only option or Album’s Program Icon

option, this adds the least to the client’s file size and uses the

appropriate icon to represent the object file.
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As mentioned previously, one of Album’s more powerful

features is the way it uses drag-and-drop between Album and

other programs. Controlling how Album behaves when you

perform a drag-and-drop operation is determined by the

options selected in the Drag-and-Drop Operation group box .

Selecting the Simulate Clipboard Copy/Paste Behavior option

makes Album perform drag-and-drop operations as if you are

using the Copy and Paste commands in the Edit menu

manually. Use this option when you only wish to copy files, not

embed or link them, or if the destination program cannot act as

a client. If you want to embed or link files, select the Paste

Embedded Object Into Client or Paste Linked Object Into Client

options respectively. For general purposes, select the Simulate

File Manager’s Behavior option. This makes Album behave in

the same manner as Windows File Manager when performing

drag-and-drop operations.

Note: If you want to embed or link an object, and are not sure which
option is selected, hold down the Shift key as you drop the
object into the destination program. This embeds the object,
irrespective of the selection made in the OLE & Clipboard dialog
box. Holding down the Ctrl key links the object.

2.4.3 Photo CD

The Photo CD dialog box gives you the option of determining

the resolution and data type of any photos imported from a

Kodak Photo CD. Any changes made here are also reflected in

the CD Browser program.
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2.4.4 Display

The Display dialog box allows you to adjust how Album displays

images.

If you are working in 256-color display mode, you can select the

View Images With a Common Palette option to display all

images using the system palette – this provides reasonable

representation of all images and makes your work quicker

because the palette is shared by each image, and therefore does

not repaint when you switch between images.

A 256-color display mode also enables the Don’t Care About

Background Quality option. If you have selected the common

palette option, this makes no difference, otherwise select this

option to prevent repainting of background images – giving you

the best representation of the active image in the fastest working

environment. (You cannot, however, compare images with this

option selected.)

The final option present in the Display dialog box is the Monitor

Gamma option which tunes your monitor to the current display.

It is very important that you calibrate your display before you

start working with images for the first time. To learn more about

how to calibrate your display, please refer to the introductory

guide.
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2.4.5 Memory

The Memory command gives you the opportunity to specify

directories which can provide additional working space when

working with images. The first directory shown is the TEMP

directory defined by the SET TEMP statement in your

AUTOEXEC.BAT file. Album provides a further three choices

that would normally be different drives. If you are working on a

network, you may have different space allocations on the same

drive; enabling you to specify more than one temporary

directory from the same drive.

2.4.6 File Formats

The File Formats command allows you to specify which image

and graphics file formats you want Album to support. When you

use Album for the first time all available file formats are placed

on the active list; this does, however, occupy system resources. If

you only work with a limited number of file formats, then use

this command to remove unnecessary formats from the active

list – in turn helping free up system resources.

Notes:

• If you have a thumbnail selected, the file format of the
thumbnail’s file appears with an asterisk; indicating that the
format is in use. If you want to remove the format from the
active list first deselect the thumbnail.

• The selections you make here are reflected in all the ImagePals
programs.
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3 Managing albums

In this chapter you will learn how to work with
albums and perform standard operations such as
creating, opening and printing album files. You
will also find sections on using the album shelf
and various maintenance commands that allow
you to copy, delete, rename, move and backup
album files.
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3.0.1 Albums on a network

Album allows you to access album files on a network. For most

albums, this works on a first-come first-served basis as albums

(in general) can only be present in one album workspace at a

time – they cannot be shared.

If you try to open an album that is already open in another user’s

workspace, you will be told that the album is being used by

another program or user. You can only open the album if it has

been removed from the other user’s workspace or that user exits

Album. When it is available, you can open it from the shelf.

Album allows you to view albums that are in read only

directories or ones that have been made read only with the DOS

“ATTRIB” command or by the Read Only option in the Album

Properties dialog box, (see p.39). In fact, unlike other albums,

read only albums on a network can be viewed simultaneously by

multiple users. In a read only album, you cannot add or delete

images, change the properties of thumbnails, or save a new user

defined order.
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3·1
Working with albums

Your first step on the way to managing the files on your system is

arranging them into albums. Each album can contain over

65,000 files. We recommend that you limit this to only a few

thousand files, both to save on system resources and for ease of

use.

The following section explains how to create an album and then

goes on to describe the various commands you can apply to

maintain and manage albums.

3.1.1 Creating a new album

You can create an album by:

• choosing the New command in the Album menu (see procedure
on the following page).

• clicking on the Album button in any of the other ImagePals
programs Save As dialog boxes and choose “New”.

• selecting thumbnails in an existing album and then choosing
the Make Album command in the Edit menu.
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Creatinga new album using the Album menu:

1. Choose “New” from the Album menu. The New Album dialog
box opens.

2. Decide on an album title and enter it in the Title entry box. The
title you enter appears in the new album’s title bar. (The first 8
characters of the title are used to make up the album’s filename.
Album files are indicated with an *.ABM file extension.)

3. Select a thumbnail size and compression scheme to display files
in the album. The larger the thumbnail size the more memory
required. For most cases select the default 80 × 80 option.

Notes:

• JPEG compression only compresses True Color and Grayscale
thumbnails, all other types are compressed using the Lossless
LZW compression scheme.

• Your compression options only affect the thumbnails and do not
change the original files.

• The Display Thumbnails in Grayscale option is enabled if you are
using a 16-color display and have selected Bypass VGA Palette to
Enable use of 16 Grays in the VGA Palette dialog box.
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4. In the Create Album File in Directory entry box, type in the
directory you want the album file to be saved in. Leave this if you
wish to accept the default directory shown.

5. In the Description entry box, type in a short description for the
new album (maximum 511 characters). (Optional.)

6. Deselect the Continue to Insert Files option if you don’t want to
start inserting images immediately after creating the album.

7. Click on the Keyword button if you wish to assign keywords to
the album, (see p.74).

8. Click OK. The new album appears in the Album workspace. (If
you have selected to insert thumbnails, the Insert dialog box
appears, see p.50.)
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3.1.2 Opening album files

When you create an album, it immediately appears in the

Album workspace. It stays there until you move it onto the shelf

or remove it. To open albums you have removed, use the Open

command in the Album menu; this returns the album to the

workspace.

If you wish to open multiple album files, hold down the Ctrl key

and click on the files you want to open. To open a range of files

click on the first file in the range and hold down the Shift key

when you click on the last file. Any intervening files will be

highlighted as part of the selection. Dragging your mouse over

the files achieves the same result.

Note: You can also open albums by dragging them from Windows File
Manager and dropping them into an empty part of the Album
workspace or onto its minimized icon (you cannot drop them on
top of a status line, toolbox, or any other open windows or
icons).
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3.1.3 Changing an album’s properties

When you create an album, you have the opportunity to define

certain properties of the album such as the title and description.

To modify these properties choose the Properties command in

the Album menu. This opens the Album Properties dialog box

which allows you to:

• change an album’s title and description.

• change the thumbnail size and compression setting.

• show thumbnails in Grayscale, (for 16-color displays only).

• mark the album as read only.

3.1.4 Arranging albums in the workspace

During your work in Album, you may want to compare the

thumbnails between albums or to better arrange your albums in

the workspace. This can be done by choosing the arranging

commands in the Windows menu: Cascade, Tile and Arrange

Icons. Cascade “stacks” open albums beneath and to the right of

each other whereas Tile resizes open albums to fill the

workspace. If you have a large number of minimized album

icons, the Arrange Icons command arranges these icons along

the bottom of the workspace.
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3.1.5 Closing albums

Closing an album file is slightly different than closing other files

such as images and text documents. If you wish to close an

album, but intend on using it later, you should place the album

onto the album shelf. If you don’t want to use the album in the

near future, choose the Remove command in the Album menu.

This removes the album from the workspace, but does not

delete the album file. To bring the album back into the

workspace, you have to open it again.
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3·2
Maintaining albums

When working with albums, it is easy to forget that they are in

fact files, and, as files, can be managed and maintained. At this

point, it is important to remember that when performing

operations on album files, you are not affecting the files

associated to thumbnails.

All the necessary commands to maintain album files can be

found in the Album: Maintenance submenu. Many of these

commands will be familiar and behave in the same manner as if

using Windows File Manager. The following section describes

each of these commands in greater detail:

3.2.1 Checking a thumbnail to its associated file

If you have been using the Windows File Manager or even DOS

to manage your files, you may inadvertently “break” the link

between some files and their thumbnails. This can be because

the original files have moved, been renamed or even deleted.

To determine if this link has been broken, use the Check

command. Album then performs a cross reference between the

thumbnails in the active album and their associated files. Any

thumbnails whose files are found missing appear with a cross

mark over their index number. These thumbnails can then be

deleted if you no longer need them, or relinked back to their

respective files, (see p.72).

Notes:

• Check cannot be performed on read only albums. To take the
read only attribute off an album, deselect the Read Only option
in the Album Properties dialog box, (see p.39).

• Checking the Enable Automatic Checking of Source Files option
in the Album dialog box automatically checks thumbnails
whenever you select them, perform a sorting operation or scroll.
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After checking the
thumbnails in this

album, thumbnails 1
and 2 still maintain

a link to their
associated files,

thumbnails 3 and 4
have lost their links

3.2.2 Moving an album file

Choosing the Move command opens the Move Album dialog

box. In this dialog box you can specify a new path and directory

to place the active album file. This moves the album file, not the

files associated to the thumbnails in the album. To move

associated files use the Move command in the File menu.

3.2.3 Copying an album file

Choosing the Copy command opens the Copy Album dialog

box. In this dialog box you can copy the active album file to a

new path and directory. This copies the album file, not the files

associated to the thumbnails in the album. To copy associated

files use the Copy command in the File menu.
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3.2.4 Deleting an album file

If you want to delete an album file choose this command. This

does not delete the files associated to any thumbnails. Once you

have deleted a file, the operation cannot be undone, as a

precaution, you may want to keep a copy of important albums

stored in your TEMP directory.

3.2.5 Renaming an album file

Choosing the Rename command allows you to rename the

active album file. When you rename the file, the title of the

album remains unchanged. To change the title of the album use

the Properties command in the Album menu, (see p.43).

3.2.6 Backing up an album file

When you back up an album, you not only back up the album

file but all those files associated with the thumbnails. This serves

two useful purposes; one, it creates a copy of the important files

you want to keep a record of, and two, allows you to delete the

backed up files to create more storage space.

If you choose to delete the original files after a backup, you can

still keep a record of them by not deleting the album file. This

allows you to view the thumbnails of the files in the album.

(To access the files you need to restore the original album.)
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To backup an album:

1. Select the album you want to backup.

2. Choose “Backup” from the Album: Maintenance submenu. The
Backup dialog box opens.

3. Use the Directories list box to select the drive and directory to
where you want to save the album.

Important: ALL files in the target directory are deleted before

backing up begins.

4. If you have selected specific thumbnails to back up, check the
Backup Selected Files Only option. Unchecked and all files are
backed up.

5. Check the Compress Files option to compress the files as they
are backed up. (Optional.)

6. Click OK. The dialog box closes and the backup begins. (The
progress of the backup is displayed in the album’s status bar.)

Notes:

• Using LZW compression, the backed up files should occupy
15%–40% less space than the uncompressed originals. Files which
have already been compressed with an LZW compression
schemes will not be compressed again and files compressed with
other compression schemes may not be compressed very much
(if at all).

• If it is important to achieve maximum compression, try
converting all image files in the album to the JPEG format. JPEG,
however, is a lossey compression scheme, as such the quality of
some compressed files may not be as good as the original.
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Backing up to floppy disks

If you are backing up to a floppy disk, you will be asked to insert

additional disks as they are filled up. During the backup

operation, Album splits files so that disks are filled as efficiently

as possible. For a rough indication of the total number of disks

required to back up an album, refer to the Total Size to Backup

indicator in the Backup dialog box and divide this by the

capacity of your disks.

Note: It is important that you sequentially number and label each disk
used during the backup. When you come to restore the album,
you will know which disks to insert and in which order.

3.2.7 Restoring an album file

After backing up an album, you must restore the album to be

able to use any of the files contained in it.

To restore an album:

1. Choose “Restore” from the Album: Maintenance submenu. The
Restore dialog box opens.

2. Using the Directories list box, locate the drive and directory
containing the album you wish to restore.

3. In the Restore To group box, select the original subdirectory or
another one to restore the backed up files to.

4. Click OK. The dialog box closes, your album and associated files
are restored to their specified subdirectories and the album
appears in the Album workspace.
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When you restore an album, any existing files with the same

filename as the files to be restored are replaced. These files may

be the files you originally backed up and did not delete, or files

you have since created. To avoid replacing these files you can:

• restore the album and its files to another subdirectory.

• rename or move the existing files before you perform the restore
operation, (see p.45).

Note: You can restore an album that has the same title as an existing
one, as long as the filename is different or you restore it to a
different directory. However, once restored, you cannot open it
in Album until you have renamed, removed or deleted the
other.
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3·3
Using the album shelf

Whenever you create an album, it appears in the Album

workspace. You can have up to 140 albums open in the

workspace at one time. Of course such a large number would

not only clutter your workspace, but make it hard to find those

albums you want to work with. To help manage albums in the

workspace, use the shelf in the toolbox.

The shelf is a storage area that allows you to place albums you

are not currently working on or wish to remove from the

workspace. We recommend that you place excess albums onto

the shelf, as this not only makes it easier to work with those

albums you often use but also frees up system resources.

Note: To access files referenced in an album on the shelf, you must
return the album back to the workspace.
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You can place albums onto the shelf in the following ways:

• drag an album icon onto the shelf button.

• open the Shelf dialog box by clicking on the Shelf icon in the
toolbox or choose the Shelf command in the View: Options
submenu, or from the menu button on the status bar. Select the
album you want to place onto the shelf from the Albums in
Workspace list box. Click “=>”, the selected album is
automatically removed from the workspace and appears in the
Albums on Shelf  list box.

• click on an album’s control menu box (or click once on a
minimized album icon) and, from the control menu, choose the
Put on Shelf command.

• use the batch manager’s Put on Shelf operation.

To retrieve albums from the shelf:

• open the Shelf dialog box by clicking on the Shelf icon in the
toolbox or choose the Shelf command in the View: Options
submenu or from the menu button on the status bar. Select the
album you want to retrieve from the Albums on Shelf list box.
Click “<=”, the selected album is automatically moved into the
workspace and appears on the Albums in Workspace list box.
Clicking Close removes the Shelf dialog box and returns you to
the workspace.
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4 Managing thumbnails

In the previous chapter you learned about albums,
and how albums help keep order of the files in your
system. This chapter takes you one step further,
explaining how to insert thumbnails of your files into
albums. Once inserted you can manipulate the
thumbnails and perform various file management
tasks such as copying, moving, renaming and deleting.



50 50 ALBUM USER GUIDE

4·1
Working with thumbnails

Once you have created an album, you can proceed to insert

thumbnails of your files. It is important to remember that the

original file never moves, it remains where it is on your disk.

How the thumbnail is represented depends on the type of file it

is linked (associated) to. If its associated file is an image or

graphics file, the thumbnail displays the contents of that file.

For video and animation files, the first frame of the sequence is

displayed. If the file’s contents cannot be shown, as in text or

sound files, the thumbnail is represented by the file’s program

icon or a default icon.

4.1.1 Inserting thumbnails of files into an album

Whether you want to insert thumbnails into an empty album or

one that already contains other thumbnails, you can:

• use the Insert command from the Thumbnail menu,
(see procedure on the following page).

• use the CD Browser program to insert photos from a Photo CD.

• drag-and-drop existing thumbnails from one album to another.

• use the Acquire command in the Album menu (only available if
you have an installed TWAIN device).

• click on the Album button in any of the ImagePals programs
Save As dialog boxes.

• drag-and-drop files directly from Windows File Manager into an
album.

Note: The thumbnail of a given file can only be inserted into the same
album once. If you insert a thumbnail from the same file more than
once, the original thumbnail and information are updated each
time.
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To insert thumbnails of files:

1. Choose “Insert” from the Thumbnail menu. The Insert dialog
box opens.

2. Using the Directories list box, locate the drive and directory
containing the file or files you want to insert .

3. Select the media type you want to choose from the List Media
Types combo box. (Choosing a type here determines which file
extensions are available in the List File Types of Media Type
combo box below.)

4. Select the file extensions of the files you wish to insert from the
List File Types of Media Type combo box.

5. Select the album you want to insert to from the Insert Files to
Album combo box. (Optional if inserting thumbnails when
creating a new album.)

6. Select the files you want to insert from the File Name list box .

Note: You can perform a quick insert of single files by double-clicking on
their filenames.

7. Check the Include all Subdirectories option if you wish to
include matching files from any subdirectories.

8. Check the Write Errors and Journals to File option if you wish to
see a report created about any problems occurred when
inserting the selected files. Use this if inserting a large number of
thumbnails and you don’t want the insertion process to be
halted if any errors occur. (This is particularly useful if inserting
files overnight.) If this is left unchecked, any problems that
occur prompt a message box and halt the insertion process.

9. Click Insert. The selected files are inserted into the specified
album. The dialog box remains open to allow you to insert more
files into albums. To close the dialog box click on the Close
button.
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4.1.2 Inserting files from a TWAIN device

If you have an installed TWAIN device, such as a frame grabber

or scanner, you can input images directly to an album using the

Acquire command in the Album menu. Choosing this command

opens the Acquire dialog box. In this dialog box you can specify

the filename, drive and directory of the file to be created. Once

created, a thumbnail of the file is automatically placed in the

active album. (If acquiring multiple images, ensure that the last

character in the filename is a number. Album will automatically

add one to this with each successive input.)

When using an auto feed scanner and scanning large numbers

of pages with information on both sides, check the Increase File

Number by Two option at the bottom of the dialog box. In the

first scan, all files are saved in consecutive odd numbers, e.g.

IMG0001.BMP, IMG0003.BMP... When you scan in the reverse

sides of the pages, the files are saved as even numbers, e.g.

IMG0002.BMP, IMG0004.BMP... This way you can be sure that

the file order is identical to your page order.

Note: Before you use the Acquire command, you have to select the TWAIN
device to input from in the Select Source dialog box, opened by
choosing the Select Source command in the Album menu.
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4.1.3 Updating a thumbnail

If the file of a thumbnail was created in one of the ImagePals

programs, the thumbnail is immediately updated each time

there is a change to the file. To update thumbnails of files

generated by other programs, choose the From File command in

the Thumbnail: Update submenu. This performs a check

between each thumbnail and its associated file. If, during an

update, Album comes across any missing files or broken links, a

cross appears over the index number of the appropriate

thumbnail. You can then choose to reinsert, relink, (see p.72) or

delete the thumbnail.

Note: If you have the Enable Automatic Checking of Source Files option
checked in the Album dialog box, (see p.25), thumbnails are
updated whenever selected or the view in the album changes. To
update a large number of thumbnails, first check this option and
then scroll through the album. Each thumbnail is automatically
updated as you scroll.
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4.1.4 Changing a thumbnail

When you first insert the thumbnail of a file it displays the

contents of that file, where possible. At times you may want to

change these contents, especially for those thumbnails whose

contents cannot be displayed, e.g. sound and text files.

When you change a thumbnail, you replace it with image or

graphics data from the clipboard using the From Clipboard

command in the Thumbnail: Update submenu. With this

method you can use your favorite images to represent

thumbnails or customize particular thumbnails to represent

particular files.

The first two
thumbnails have

been changed with
an existing image

file
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4.1.5 Selecting thumbnails

When you perform an operation, it is applied to all the

thumbnails in an album, or to selected thumbnails only. You

can select or deselect thumbnails in the following ways:

• to select one, click on it.

• to select a range, click on the first thumbnail in the range and
then, with the Shift key held down, click on the last.

• to select or deselect individual thumbnails, hold the Ctrl key
down and click on the ones you want to add to, or delete from
the current selection.

• in the Search dialog box, choose the Select option in the Action
to Take combo box. Any thumbnails matching the search
criteria are selected.

Using the Edit: Select submenu, you can select or deselect

thumbnails with the following commands:

• All selects all the thumbnails in the current view.

• None deselects all selected thumbnails. (Clicking on an album’s
status bar has the same affect.)

• Invert selects the thumbnails which are not currently selected
and deselects the ones selected in the current view. This is
useful if you want to select a large number of thumbnails while
wanting to exclude one or two. In such cases select the ones you
do not want and then invert the selection.

Note: If you only want to view selected thumbnails, choose the Selected
command in the View menu. To display all the thumbnails again,
choose the All command from the same menu or click on the view
all button in the search ribbon.
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Thumbnails, 1, 3
and 4 are selected
and appear with a

highlighted
filename

4.1.6 Using the clipboard

One of the easiest ways to move thumbnails is by dragging them

and dropping them into other albums. Other means involve

using the clipboard and the Cut, Copy, and Paste commands in

the Edit menu.

Cutting a thumbnail removes it from the album and places it

onto the clipboard (only the thumbnail is cut; the thumbnail’s

file is not affected and remains where it is). If you choose to use

the Copy command, you have the option of copying the

thumbnail, its associated file or filename. Copying a filename is

useful, particularly if it has a long pathname and you wish to use

it in any of the file access dialog boxes, such as the Open dialog

box, or when referencing it in a text document.

Note: If you want a program to automatically open the same file each
time you access it, paste the filename into the command line of the
Program Properties dialog box, accessed by choosing the Properties
command in the tool button menu. If the program supports the
opening of files with a command line, the file will automatically
open each time you invoke the program via the toolbox.
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Pasting thumbnails into an album

The Paste command is available when the clipboard contains

thumbnails that have been cut or copied from an album. In

user-defined sort mode, (see p.99), pasted thumbnails are

placed at the end of an album. In other sort modes they are

placed according to the sort order.

Note: If you paste thumbnails into an album that already contains the
same thumbnail, the existing copy is replaced.

4.1.7 Printing

Album allows you to print an album, thumbnail, associated file

and keywords to any Windows compatible output device. Before

you print, however, make sure that your output device is turned

on, connected, and selected in the Printer Setup dialog box. You

can access this dialog box through the Printer Setup command

in the Album menu.

When ready to print, choose the Print command in the Album

menu, a submenu appears with the following commands:

Album

When you want to print out information on all the thumbnails

contained within an album, choose the Album command. This

opens the Print Album dialog box where you can define what

information to print, such as the thumbnail, file attributes,

keywords, subjects and descriptions. You can print individual

options or all at the same time.
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When printing out thumbnails, you can determine their size in

the Thumbnail Size spin box, from 1/2 an inch square to 3

inches square. To print only the currently selected thumbnails,

check the Print Selected Items Only option. For the best possible

representation of thumbnails, check the Create Thumbnails

From Original File option. This produces a clearer thumbnail,

but does slow down processing time.

Other options are also included in the Page Setup dialog box,

accessed by clicking on the Page button. Here you can change

the page layout, create a header and/or footer as well as choose

to append any relevant file information.

Thumbnails

To print information regarding individual thumbnails choose

the Thumbnails command. This opens the Print Thumbnails

dialog box. When you print a thumbnail, you can include its

filename, index number and thumbnail slide. You can also

control how many thumbnails appear on each page as well as

the size of each thumbnail.

Checking the Create Thumbnails From Original File option

produces a clearer thumbnail, but does slow down processing

time. To print only selected thumbnails check the Print Selected

Items Only option. (This is disabled if no thumbnails are

selected.) If you have not selected any thumbnails, all

thumbnails in the album are printed.
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Keywords

If any of your thumbnails have keywords assigned to them, you

can print out those keywords by choosing the Keywords

command. The Print Keyword dialog box opens. This is a useful

command to use when you want to print a list to cross reference

your keywords to filenames. Select the keywords to print by

highlighting them in the Keywords to Print list box .

Other options are also included in the Page Setup dialog box,

accessed by clicking on the Page button. Here you can change

the page layout, create a header and/or footer as well as choose

to append any relevant file information.

File

If you want to print out the file of a thumbnail, choose the File

command. The Print File dialog box opens. This dialog box

contains the following options:

In the Title entry box you can enter a title for the images to be

printed. (The default, “&f”, prints the filename.) Checking the

Scale to Fit the Page option scales the file to be as large as

possible on the page while maintaining its aspect ratio. With this

option unselected, the file prints at the size determined by its

resolution.



60 60 ALBUM USER GUIDE

The Center Image Horizontally, Center Image Vertically and

Start From Top Left Corner options allow you to choose where

images print on the page. If both the center options are selected,

images print centered on the page. (Choosing these options

disables the corresponding From Top or From Left option.)

Note: For some application-linked files, their associated program will be
called up to the print the file. Once printed the program will then
close. For example, to print a Write document, Write is opened with
the selected document in the workspace; the Print dialog box also
appears. Enter your print settings and click OK. The file is printed
and Write closes, returning you to Album.
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4·2
Viewing

Thumbnails are a way of viewing the contents of files. You are

not however restricted to viewing them in this mode only. You

can view them as filenames – just like the File Manger of

Windows. (You can view different albums in different modes.)

To change the viewing mode of an album, select the album in

the workspace (by clicking on its title bar or icon) and then

choose the Thumbnails or Filenames command from the View

menu. The following provides a brief explanation of what

information is displayed when you choose either of the viewing

modes:

• Thumbnails displays the thumbnails of files from left to right
and top to bottom in an album. You can also choose whether or
not to display the filenames, subjects or slides of thumbnails
using the Album preferences dialog box, (see p.25).

• Filenames displays filenames from top to bottom in the album.
Depending on selections made in the Album dialog box, (see
p.25), various information is displayed about each file, such as:
file attributes, subject, description and pathname. (Viewing in
filename mode is quicker than thumbnail mode, and requires
less memory.)

Viewing files in
filename mode
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4.2.1 Scrolling an album

Album provides several methods for locating thumbnails in an

album. The most obvious is the scroll bar, which appears on the

right side of the album when it is not possible to display all the

thumbnails in the current view. Clicking on the scroll bar

direction buttons moves the view by a single line. Clicking in the

scroll bar moves the view by a page, and dragging the slider

allows you to move quickly to a new location.

If you have a large number of thumbnails in an album you can

automatically scroll them by choosing the Auto Scroll command

in the View menu. The Auto Scroll dialog box opens. In the

Delay Time entry box, type in a the time (in seconds) you want

Album to wait before each scroll. When ready, click on the OK

button. The dialog box closes and automatic scrolling begins.

(To pause/continue scrolling, press the Space bar, to stop

scrolling press the Esc key.)

If you want to go to a specific thumbnail, choose the Scroll To

command in the View menu. This opens the Scroll To dialog box

which lists the filenames and index numbers of all the

thumbnails in the album. Selecting a filename and clicking OK

automatically scrolls the thumbnails to the location of the

selected filename. (Double-clicking on a filename performs the

same effect.)
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4.2.2 Performing a slide show presentation

Album provides a slide show feature which allows you to

showcase your image, graphics and sound files. This includes

using impressive transition effects and providing manual or

automatic playing. Apart from its obvious value as a

presentation tool, slide show can also serve as a personalized

screen saver.

To create a slide show:

1. Choose “Slide Show” from the Thumbnail menu. The Slide
Show dialog box opens.

2. In the Transition group box decide on a transition effect. To
control the speed between each slide, use the Speed slider. To
determine how the slide show plays the presentation, select
either the Delay (in seconds), Synchronize With Audio Files
(displays a new slide once an audio file has finished playing), or
Manually With Keyboard or Mouse options, (use this option if
you want to control the transition yourself).

3. Select other options such as: Continuous Repeat, Resize Large
Images to Fit Screen, Use a Common Palette to Show Pictures
(16-Color display mode only) and Hide Pointer During Slide
Show. (Optional.)

4. In the Attributes group box click on the Text, Bkgd Color and/or
Bkgd Music buttons to define their respective attributes.

Notes:

• You can only play MIDI files as background music.

• If you have the Synchronize With Audio Files option checked, the
time specified in the Delay option is used as a pause between each
audio file.
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5. Once you are satisfied with the settings, click OK. The files are
loaded to memory and the slide show begins. (If you selected
the Manually With Keyboard or Mouse option, the Slide Show
Controls dialog box opens detailing the respective keyboard or
mouse operations used to control the playing of the slide show.)

Once you have played a slide show, you may want to retain the

same slide show settings for future use. To do this, click on the

Save button to save your settings to file. Click on the Load button

to bring your settings back into the slide show .

When you load a settings file, all the settings currently chosen in

the Slide Show dialog box change to the new configuration.

Once loaded, you can still change the settings to suit the

particular type of slide show you are preparing, but the original

file remains unchanged unless you resave it.

4.2.3 Viewing image and graphics files

If a thumbnail’s file is an image or graphics file, you can view it

using the Viewer program of ImagePals, (see p.111). This is

particularly useful if you want to compare multiple files at their

original size, or just to see a file in greater detail. To open a file in

the Viewer program, double-click on its thumbnail or select the

thumbnail and choose the File command in the View menu.

Once a file is displayed in a Viewer window, you can perform

basic editing functions such as copying the file, or portions of

the file to the clipboard. You can then paste the data into

another compatible file or use it to change a thumbnail’s

representation, (see p.54).
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4.2.4 Displaying information

You can display information about the file of a thumbnail in two

ways: choosing the File Information command in the View

menu, or by clicking on a thumbnail with the right mouse

button. Choosing the File Information command opens the File

Information dialog box. Here you can find information about

the attributes of the file as well as details including the filename,

file format and space occupied on disk, and whether the file is

read only. Clicking on the More button displays additional

information about any masks, keywords, subjects or

descriptions associated with the file. (Clicking the right mouse

button on a thumbnail displays similar information in a pop-up

dialog box.)

Note: For different files and formats the information provided may vary.

To display information about an album, choose the Album

Information command. This opens the System Information

dialog box. Here you can find information about the attributes of

the album, thumbnails, files, and compression schemes. The

description of the album is also displayed, as well as any

keyword lists and mark files.
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4.2.5 Displaying program features

The Options command in the View menu provides a submenu

of commands to show and hide various features of the Album

program window. These include the shelf, toolbox, mark palette

and search ribbon. Choosing one of these commands hides the

appropriate feature – choose it again to show it. These

commands can also be found in the button menu on the left of

the status bar.

Note: The toolbox and mark palette can also be hidden by choosing
the Close command in their respective menus.
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4·3
Maintaining files

Once files are represented in an album, you can manage them

just as you would from Windows File Manager. This includes

copying, deleting, renaming and moving files on disk. You can

even convert the data types and file formats of files as well as

change their attributes and program association.

All the commands to manage files are contained in the File

menu. These commands behave in much the same way as those

previously discussed in the Album: Maintenance submenu. The

major difference being that File commands are applied to a

thumbnail’s file and not to the album itself. The following

describes each of these commands in greater detail:

4.3.1 Converting a file’s format

The Convert File Format command lets you convert image and

graphics files into a variety of different file formats. This

command can be applied to individual or multiple files, sharing

the same or different formats. Changing file formats is

particularly useful when you want to open a file in a program

that doesn’t support a file’s current format, e.g. changing *.TIF

files to a *.BMP format so they can be opened in Paintbrush.

When you choose this command, the Convert File Format dialog

box opens. In this dialog box you can select to save the

converted files in the same directory, or have them saved in

another subdirectory. You can also delete the original files after

conversion or choose to insert thumbnails of the converted files

into an existing album.
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4.3.2 Converting a file’s data type

The Convert Data Type command allows you to convert image

and graphics files from a variety of data types into a common

data type. This is especially useful when you are preparing a

large number of images for publication, e.g. converting your

images from RGB True Color to Grayscale.

When you choose this command, the Convert Data Type dialog

box opens. In this dialog box you can choose the target format

and destination of the files and whether to delete the original

files and/or insert the new files into an existing album.

4.3.3 Moving files

Choose the Move command if you want to transfer the files of

selected thumbnails to a new path and directory . After moving,

thumbnail information is updated to reflect the files’ new

location.
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4.3.4 Copying files

Choosing the Copy command opens the Copy Files dialog box.

Here you can copy the files of selected thumbnails to a new path

and directory. There is also an option to insert thumbnails of the

copied files into a new album. (If you want to copy a file to the

clipboard, use the Copy command in the Edit menu, see p.56.)

4.3.5 Deleting files

The Delete command deletes files from disk as well as removing

the selected thumbnails from their album. This command

cannot be undone. As a precaution, make a back up of your files

or keep a copy of your important files in the TEMP directory.

Removing thumbnails from albums

Sometimes you will want to remove thumbnails from albums. It

could be that you no longer need them or that they should not

have been in the album in the first place. Removing a thumbnail

from an album doesn’t affect the associated file on disk. If you

remove a thumbnail accidentally, use the Undo command in

the Edit menu or insert it again from the original file.

To remove a thumbnail, select it and choose the Clear

command in the Edit menu, or press the Del key. The selected

thumbnail is removed from the album.
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4.3.6 Renaming files

Use the Rename command to change the filenames of those

files whose thumbnails you select. A filename can be up to eight

characters long. (It is not necessary to type in a file extension.) If

you select multiple files, all filenames will change to the same

name, only the file extensions remain different. (You cannot

rename files that share the same file extension.)

Note: You can use DOS wildcards when renaming multiple files. For
example, the string “NEW*.TIF” will replace the first three
characters of all the selected files to NEW.

4.3.7 Changing a file’s attributes

Choosing the Attributes command allows you to change the

attributes of the files whose thumbnails are selected. These

attributes can be: Read Only, Archived, Hidden or System. A

read only file allows you to open the file but prevents any

changes being saved to it. This is useful when sharing files over a

network and you do not want anyone changing the content of

your files. The archived option identifies those files, with an

asterisk, which have been updated since their last backup.

Selecting the Hidden attribute hides files from view and System

marks files as MS-DOS system files, also hiding them from view.
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4.3.8 Changing the program association of a file

The Associate command allows you to change the association

between a file and the program it was last saved in. You will

want to change the association of a file when, for example, you

double-click on a filename in Windows File Manager and the file

opens in a different program than expected. (Such situations

often happen when you use different programs to work on the

same file.)

Choosing the Associate command opens the Associate dialog

box. In this dialog box you specify the file extension whose

program association you want to change. If you do not select

any thumbnails, this command affects all thumbnail files

sharing the same extension.
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4.3.9 Relinking thumbnails to their associated files

When the thumbnail of a file is inserted into an album, it

maintains a link to the location of this file. This is why you can

manage files by manipulating their thumbnails. If files have

been moved using DOS or Windows File Manager, or, if you

remap your disk drives, Album may lose this link. Thumbnails

that have lost their link appear with a cross mark over their index

number. (The File command in the View menu is also disabled

for such thumbnails.) If you want to reestablish this link, you can

reinsert the thumbnail for the file or use the Relink command.

To relink thumbnails:

1. Select the thumbnails that need relinking.

2. Choose “Relink” from the Thumbnail menu. The Relink dialog
box opens.

3. Select the drive and directory that contains the files you want to
relink the thumbnails to.

4. Click OK. The dialog box closes and the relinking process
begins. The thumbnails are compared against the files present
at the new location, their paths are updated and, if necessary, so
too are their thumbnails and information.
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5 Labeling thumbnails

Albums are essentially databases that provide an
easy-to-use and efficient way of cataloging and
managing files. As with any database, its real worth
is how it allows you to organize, label and search for
information related to these files. This chapter, and the
next, explain how Album achieves this by using
keywords, marks, subjects and descriptions.
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5·1
Defining keywords

Keywords are phrases that can be assigned to the thumbnails of

files to help you conveniently group files which share common

themes. For example, the keyword “Sports” can be assigned to

all those files in an album that have a relationship to sports.

A keyword can consist of one word, such as “sun”, or multiple

words such as “sun in Hawaii”. (When using multiple words,

ensure that each word is separated by a space.)

You can define keywords in the following ways:

• choosing the Keyword command in the Album menu, (see
procedure on the following page). Using this method you can
easily assign the same keywords to multiple thumbnails as well
as perform keyword searches.

• clicking on the Keyword button in the New Album dialog box,
(opens the Keywords dialog box).

• adding it to the Keywords list in the Thumbnail Properties dialog
box, (see p.83). To use the same keyword repeatedly, it is best to
use the first method described above.
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To create a keyword list:

1. Select the album you want to assign the keyword list to.

2. Choose “Keywords” from the Album menu. The Keywords
dialog box opens.

3. In the New Keyword entry box type in a keyword. Click on the
Add button or press the Enter key to add the keyword to the
keywords list box. (If there are existing keywords, the Change
button is also enabled. Clicking this button changes the
highlighted keyword in the list to the keyword appearing in the
New Keyword entry box.) To add more keywords repeat this
procedure.

If you wish to adopt a keyword list from another album open in
the workspace, select the album from the Adopt Keywords From
Album combo box. This places the album’s keyword list (if it has
one) into the keywords list box.

4. Click OK. The dialog box closes and the keywords are now
associated to the album. To assign the keywords to a thumbnail,
use the Thumbnail Properties dialog box, (see p.83).

Note: The total size of keywords in an album cannot exceed 65,536
characters. You can assign as many as 32 keywords to a thumbnail.
Each keyword cannot exceed 31 characters.
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5.1.1 Saving and loading keywords

When you create a keyword list you can save it for future use or

editing. To do this, click on the Save button in the Keywords

dialog box. This opens the Save Keywords dialog box. Select the

path you want to save the keyword file to and type in a filename,

choosing either a DOS or Windows *.TXT file extension. Use

Windows if you are working with Windows, DOS if you want to

transport your file to a DOS application program for editing.

To add keywords from an existing keyword file, click on the Load

button in the Keywords dialog box. The Load Keywords dialog

box opens. Choose the appropriate keyword file and click OK.

You will be asked if you want to retain the current keywords.

Selecting YES adds the keywords to those currently in the

keyword list box; NO replaces the current keywords with those

of the file.

If preparing a large number of keywords, you may find it easier

to first compile the keywords in a word processing program and

then load them into an album. Doing so, you can easily edit and,

where possible, spell check your work. (If using a word

processing program, each keyword must be separated by a

paragraph break.)
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5·2
Defining marks

Marks serve as visual tags for thumbnails in albums. In a sense

they are very similar to keywords differing only in implemen–

tation. Whereas keywords work “behind the scenes”, marks are

clearly displayed on the thumbnail slide. You will find marks

particularly useful when you want to quickly navigate around an

album and pin-point certain thumbnails for future operations.

5.2.1 Assigning marks

To assign marks you need to use the mark palette. This is a

floating palette that allows you to assign up to 26 marks to a

thumbnail. To move the palette drag on its title bar, or, if you are

using the keyboard, choose the Move command in the mark

palette control menu. Each mark is represented by a letter of the

alphabet and once assigned the letter is displayed next to the

index number on the thumbnail slide, (see procedure on the

following page).
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To assign a mark:

1. Open the album containing the thumbnails you want to assign
marks to.

2. If the mark palette is not open, choose “Show Mark Palette”
from the View: Options submenu. The mark palette opens. (The
same command can also be accessed from the menu button on
the status bar.)

3. Double-click on any letter in the mark palette, the Edit Marks
dialog box opens. (This dialog box can also be opened with the
Edit command in the mark palette control menu.)

4. Select the letter you want to assign from the Marks list box. In
the Mark Name entry box type a description (up to 31
characters).

Note: You can edit and assign descriptions to any mark by simply clicking
on it and then entering a description in the Mark Name entry box.
If you wish to use marks already present in another album select
the album from the Adopt Marks From Album combo box. The
marks, if any, appear immediately in the Mark list box.
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5. Click OK. The dialog box closes, returning you to the Album
window. The description of the mark now appears in the mark
palette.

6. Click on the mark to assign in the mark palette. The View and
Assign buttons are enabled. To assign multiple marks, hold
down the Ctrl key and click on each mark to select it. (Clicking
again deselects the mark.) To select a range of marks, click on
the first mark in the range and, holding down the Shift key, click
on the last. All marks in the range are selected. (Dragging your
mouse over the marks performs the same function.)

7. Click on the Assign button, the Assign button changes to Stop
and, when you move your pointer onto an album, the pointer
changes to the mark pointer.

8. Place the mark pointer on the thumbnail you wish to mark and
click once. The letter of the mark is immediately shown on the
top left corner of the thumbnail slide, next to the index number.
(Clicking again removes the mark.) Repeat this procedure if you
want to assign the same mark to another thumbnail.

9. When you have finished assigning the current mark, click on the
Stop button in the mark palette, the button changes to Assign.
To assign another mark repeat steps 6 to 8. (You can assign more
than one mark to the same thumbnail.)

Note: To remove the mark palette, double-click on the title bar or choose
the Hide Mark Palette command in the View: Options submenu.

Examples of marked
thumbnails
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5.2.2 Viewing marks

The advantage of using marks is that they are quick and easy to

apply and you can see which thumbnails have been marked

accordingly. When you want to view marked thumbnails the

procedure is just as convenient.

To view marked thumbnails:

1. Open the album which contains the marked thumbnails you
want to view.

2. If the mark palette is not open, choose “Show Mark Palette”
from the View: Options submenu.

3. Select the letter or letters in the mark palette you wish to view.

Note: To select individual marks, hold down the Ctrl key and click on the
mark to select it. (Clicking again deselects the mark.) To select a
range of marks, click on the first mark in the range and, holding
down the Shift key, click on the last. All marks in the range are
selected. (Dragging your mouse over the marks performs the same
function.)

4. Click on the View button, the View menu opens with the
commands AND, OR and View All. Choosing AND immediately
displays those thumbnails that contain all the selected marks.
For example, if you have selected the marks A, B and C, only
those thumbnails with the marks A, B and C are displayed.
Choosing the OR command displays those thumbnails with
either one of the selected marks. To display all the thumbnails in
the album, choose the View All command or click on the view all
button in the search ribbon.

Note: To view a diverse range of marks, use the Marks command in the
Thumbnail: Search by Item submenu, (see p.95).
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5.2.3 Managing marks

When it comes to managing marks in an album you can choose

from a number of commands in the mark palette control menu.

These commands are particularly helpful when you want to

perform batch operations over a large number of thumbnails.

Performing a batch mark assignment

To assign the same mark to many thumbnails, you can mark

each one individually, as demonstrated in the previous

procedure, or first select them, and then use the Assign Selected

command in the mark palette control menu. This automatically

affixes the currently selected mark or marks to each thumbnail.

Removing marks

To remove specific marks from thumbnails, first select the

marks you want to remove and then select the thumbnails you

want to remove them from. Click on the control menu of the

mark palette and choose the Clear Selected command. The

selected marks are removed from the appropriate thumbnails.

To remove all the selected marks in the active album, choose the

Clear All command, (this command is disabled if no marks are

selected).

Loading and saving marks

Whenever you assign a mark, it is recorded as an MRK file in the

same directory of the album file. If other people share the same

album, such as a Photo CD, you can send this file to them, and

have them load it into their machine using the Load command

in the mark palette control menu. This provides you with a

convenient method of bringing to the attention of another user

any thumbnails you may want to highlight. To only send the

marks of a few thumbnails, select the concerned thumbnails

and then save these as a new MRK file with the Save command.
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Converting marks to keywords

There may be times when you would like to use the same

mark as a keyword. This allows you to include the mark in a

thumbnail’s properties, as well as using the mark when

performing more complex searches. You may also find it easier

to define keywords in this way rather then using the Keywords

dialog box.

To convert marks to keywords:

1. Select the mark or marks you want to convert.

2. Select any thumbnails you want to remove the selected marks
from. (Optional.)

3. Choose “Convert to Keywords” from the mark palette control
menu. The Convert to Keywords dialog box opens.

4. Check the Clear Marks From Selected Thumbnails option to
remove the mark, or marks, from any selected thumbnails after
they have been converted to keywords. Checking the Clear
Mark Name From Palette option removes the mark, or marks,
from the mark palette after the conversion. (Optional.)

5. Click OK. The selected marks are converted to keywords and will
now appear in the Keywords dialog box. Depending on your
options selected in the Convert to Keywords dialog box, the
marks will also be removed, or remain unchanged, from any
selected thumbnails and the mark palette.



LABELING THUMBNAILS 83

5·3
Assigning thumbnail properties

Thumbnails, by their very manner, allow you to append a great

deal of information about a file, thus making it easier to locate

and identify your files. This information consists of keywords,

subjects and descriptions. All of which are user-defined, fully

searchable and can be applied to individual or multiple

thumbnails.

As mentioned in the previous section, keywords can be used to

group like files together. Subjects help extend on keywords by

providing brief titles, such as “skiing in the Alps”, which add

further information about the file. Descriptions on the other

hand offer more detailed information about any one file, such as

observations about what the file contains, date and time or any

particularities that should be remembered for later recall.
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To assign a keyword, subject or description to a thumbnail:

1. Select the thumbnail whose properties you wish to assign.

2. Choose the Properties command in the Thumbnail menu. The
Thumbnail Properties dialog box opens.

3. If assigning keywords, click on the Keywords List combo box
and select the keyword you wish to assign. (If the album has no
keywords, or you wish to create a new one, enter its name
directly.) Press Enter to place the keyword into the Keywords list
box. If assigning a subject or description, type your comments in
the appropriate Subject or Description entry boxes.

Note: Keyword text cannot exceed 31 characters, subject text 127
characters, and description text 4095 characters.

4. Click OK. The dialog box closes and the thumbnail’s properties
are updated.

If no thumbnails are selected, or you have selected multiple

thumbnails, the Next and Go To buttons are enabled. Click on

“Next” to step through the thumbnails and stop on the one

whose properties you want to change. If you want to edit a

specific thumbnail, click on the Go To button. The Go To dialog

box opens listing available thumbnails. Select the one you want

and click OK. The thumbnail now appears in the Information

group box and any properties it may already have are displayed

in the appropriate entry boxes.

Note: Double-clicking on the thumbnail in the Information group box
opens the file of the thumbnail in its associated program, where
possible.
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5.3.1 Saving and loading properties

Having assigned properties, you can save these to a file and then

export it to a text editing program. In this way you can easily edit

and, where possible, spell check your work. Clicking on the Save

button in the Thumbnail Properties dialog box opens the Save

Properties dialog box. Select the path you want to save the

properties file to and type in a filename, choosing either a DOS

or Windows *.TXT file extension. Use Windows if you are

working with Windows, DOS if you want to transport your file to

a DOS application program for further editing.

At the bottom of this dialog box are the three properties options,

Keywords, Subject and Description. By default, all three are

checked. If you want to save a selected property, uncheck the

ones you do not require. This allows you to load only the

selected property back into the original thumbnails – without

affecting other property information.
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Notes:

• When you save properties to file, additional file information
appears identifying the particular properties as well as the file of
the thumbnail. Therefore, it is impossible to save the properties
from one thumbnail and then load it into another without first
altering the file location data manually. When you open a
properties file in an editing program, it displays the following file
location and properties information:
[c:\pals2\manual\editor\woman.tif]
Keyword=woman, history, old English
Subject=Woman sitting on rocking chair.
Description=Image prepared for ImagePals 2 user guides.

• When adding keywords to a properties file, separate each keyword
with a comma followed by a space.
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6 Locating thumbnails

The previous chapter discussed how to assign marks,
keywords, subjects and descriptions to thumbnails.
This chapter explains how you can use these properties
to pin-point where in an album, or albums, specific
thumbnails are located; using either the search ribbon
for quick one step searches, or one of the search
commands for more complex multiple criteria-based
searches.
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6·1
Search basics

Album brings with it a variety of commands and features to

provide you with the most precise means of locating thumbnails

and their associated files. In all, there are three methods you can

use to perform searches. The first is using the search ribbon for

quick, on-the-spot searches, the second, choosing a user

defined search command from the Thumbnail: Search by Query

submenu, and the third, creating multiple criteria searches with

the Search, or Search by Item commands in the Thumbnail

menu.

Before you begin to perform searches, however, you need to

have a clear idea of some of the logic behind search operations.

The following section explains this logic which will help you

better understand the possibilities available when using the

search facilities of Album.
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6.1.1 Search criteria and queries

Whenever you perform a search, you must first specify what it is

you want to search on (the criteria). This can be anything from

keywords, filenames or data types. Once you select a criteria,

you need to further define which aspect (the query) of the

criteria to look for. For example, if you have chosen the criteria

'filenames', the query would be the filename you are looking for.

Note: If the query consists of more than one word, you must encase it
with double quotes, e.g. “New York”.

6.1.2 Boolean operators

One of the more powerful features of Album is its use of logical

(Boolean) operators: NOT, AND, OR and ( ). These allow you to

search a vast number of files quickly, looking only for specific

file features. Below is a brief description of how each of the

operators work:

NOT, is used to define the opposite of the indicated criteria. This

allows you to isolate thumbnails whose file’s format makes it a

minority in the album. For example, in an album consisting

largely of *.TIF files, performing a file format search – NOT *.TIF,

results in all thumbnails, except those whose files are of the *.TIF

format, being displayed.

AND, allows you to specify more than one criteria to search on.

(Matching thumbnails must meet all of these criteria.) For

example, to find thumbnails about your holiday in Spain, you

could perform a subject search on – “holidays AND Spain”. All

thumbnails with the words holiday and Spain in their subjects

are displayed.
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OR, allows you to match thumbnails that meet one or more

of a specified criteria. For example, performing a filename

search on – F*.* OR G*.*, will display only thumbnails whose

files begin with an F or G.

( ), the parenthesis are used to group criteria together. This is

particularly important if you have several queries, some of

which must be paired together. For example, if you are

searching on the values, A, B and C, then you could define the

search as, “A AND (B OR C)”, or “(A AND B) OR C”. In the first

example, the thumbnails must have A and either B or C. In the

second example, the thumbnails must have either A and B

together, or C only.

Note: To use an operator simply double click, (or select), on the desired
operator in any of the dialog boxes that support this feature. The
operator appears in the Query entry box.

Some examples of what you can achieve using Boolean
operators.

The following examples are provided to give you an idea of how

to perform more complicated searches. Depending on the

search command used, some of these options may or may not

be available.
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•jhOperator Criteria Query

 File Name  new*.tif

 AND NOT  Image Data Type  Indexed 16-Color

This query searches for all TIF files which begin with the letters

NEW and are not Indexed 16-Color.

•jhOperator Criteria Query

 Keyword  holidays AND “image editor”

 OR  Description  “lying on the beach”

 AND  Date  from 4/18/93 to 2/05/94

This query searches for all thumbnails which have the keywords

“holidays” and “image editor” or have the phrase “lying on the

beach” in their description. The files of these thumbnails must

have been created between 4/18/93 and 2/05/94.

•jhOperator Criteria Query

 Media  Image

 AND  Keyword  “user guide” OR (user AND guide)

 AND  Subject  Children [Case]

 AND NOT  Description  “lying on the beach”

This query searches for all thumbnails which are of the image

media type, have “user guide” or the words “user” and “guide”

as their keywords, have “Children” in their subject (matching

case) and do not include the phrase “lying on the beach” in their

description.
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6.1.3 Match case and match whole word

When performing a search on text, many of the search dialog

boxes allow you to “match case” or the “whole word”. Matching

case tells Album to find those thumbnails matching the upper or

lower case of the query. For example, to match the case of “New

York”, only New York would be selected, any variations, such as

“new York” or “NEW YORK” would be ignored.

Matching the whole word searches on occurrences of a defined

word. For example, to match the word “man”, only man would

be selected, not manage. If this option is left unchecked, any

occurrence of the letters (not the word), m-a-n will be selected,

such as man, manage and human .

Note: Selecting Match Whole Word performs a search much quicker than
leaving this option unselected.
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6·2
Performing a search

Performing a search can be as simple, or complex, as you want

to make it. In most cases you will be performing simple, single

criteria searches which are best done from the search ribbon,

(see p.97). If you want more control over the search process then

choose one of the search commands in the Thumbnail menu.

Some notes before you start:

• Although the search dialog boxes share similar features, it is not
possible to itemize all the possible search variations here. The
best method is to read the previous section on search basics,
and then experiment with your own variations.

• In some search dialog boxes, you will find that the criteria and
query can be very complex and involved. Try working out your
search on paper first before entering it into a Query entry or list
box.

• Whenever you perform a search, the search is done only on the
thumbnails in the current view of the active album. If you want
to perform consecutive searches, be sure that the Search Entire
Album command in the Thumbnail menu is checked. (The
same command can also be accessed from the menu button on
the status bar.) Alternately you could click on the view all button
or select the View All command in the View menu. The next time
Album performs a search, all thumbnails in the album will be
included, irrespective of the results of the previous search or
current view.
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6.2.1 Defining a search query

To define complex searches, or to create a user defined search,

you need to access the Search dialog box. This allows you to

search on any criteria and query and in any combination. If you

want to search on a single criteria only, use one of the other

search commands in the Thumbnail: Search by Item submenu,

or select a criteria from the search ribbon.

To perform a search using the Search dialog box:

1. Open the album you want to perform the search on.

2. Choose “Search” from the Thumbnail menu. The Search dialog
box opens.

3. Select the criteria you wish to search on in the Search Criteria
combo box. Depending on the criteria chosen, define your
query. (For multiple queries click on the appropriate operator.)

4. Click on the Add button. The query is now placed in the list box
underneath. To include additional criteria, repeat steps 3 and 4.
To change a query, select the query in the list box and redefine
the criteria and query from the Search Criteria group box. This
time, when you are ready to add the query, click on the Change
button. This replaces the query selected in the list box with the
new one. To remove a query, highlight it and then click on the
Remove button.

5. To search all albums in the workspace, check the Search all
Albums in the Workspace option.

6. In the Action to Take combo box select View, Go To or Select.
View displays the thumbnails matching the search criteria. Go
To indicates where in an album, with a yellow arrow, the
thumbnails are located and Select selects those thumbnails
matching the search criteria.
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7. If you want to save the query for later use, type in a name in the
Query entry box and press Enter. To remove an existing query,
highlight it and click on the Remove button. To edit a query,
select it from the Query entry box, the contents of the query are
displayed in the list box.

8. Click OK. The search is performed and, if you defined a query,
the query is saved and added as a menu command in the Search
by Query submenu.

Note: Depending on the media type and file format of the thumbnail
files, some options may be disabled.

6.2.2 Search by Item

If you have assigned keywords, subjects or marks to thumbnails,

you can search on these criteria by choosing the Search by Item

command. A submenu appears listing the following commands.

Keywords

Choosing the Keywords command opens the Search by

Keywords dialog box. All the assigned keywords in the active

album are displayed in the Keywords list box. Double-click on

the keyword to place it into the Query entry box . To search on

multiple keywords use the Boolean operators.
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Subjects

To search on only the subject of a thumbnail, choose the

Subjects command. This opens the Search by Subjects dialog

box. Here you can type in a text string to search on the subjects

of thumbnails. (If you use multiple words, ensure to place

“double quotes” at the beginning and end of the string.) To aid

in your search, use the Boolean operators as well as the Match

Case and Match Whole Word options.

Marks

Using the mark palette is one means of locating thumbnails

when working in an album. You can also locate marked

thumbnails with the Search by Marks dialog box, opened by

choosing the Marks command. All the assigned marks in the

active album are displayed in the Marks list box. Double-click

on a mark to place it into the Query entry box. To search on

multiple marks use the Boolean operators.

6.2.3 Search by Query

Any queries defined in the Search dialog box appear in this

submenu. To apply a query, simply choose its name from the

submenu list; the search begins immediately. To edit or remove

queries, you have to select them from the Query entry box in the

Search dialog box.
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6.2.4 Using the search ribbon

Many of the search criteria found in the search dialog boxes can

also be accessed directly from the ribbon. You will find the

search ribbon a much more convenient and quicker way to

perform single criteria searches. To use the search ribbon, select

a criteria to search on from the criteria combo box, the first on

the left. The query box changes to suit the chosen criteria. In the

query entry box, define your query. Click on the search button,

(on the left), the search is performed and any thumbnails

matching the search criteria are displayed in the album. To

show all the thumbnails, click on the view all button.

The above query searches for TIF files that begin with the characters NEW

The above query searches for thumbnails with the keyword “competition”

The above query searches for files last saved between April 18, 1993 and February 5, 1994

The above query searches for thumbnails whose description contains the words “public
relations”
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6·3
Sorting thumbnails

When you first create an album, thumbnails appear in their

order of insertion. This order can be identified by the index

number that appears on the top left side of each thumbnail

slide. Any new thumbnails are placed after those already

present. Using your mouse, you can freely move thumbnails by

dragging and dropping them anywhere within the album,

changing their order accordingly. Apart from this method, there

are also several sort mode commands in the Thumbnail: Sort by

submenu that allow you to define the order of thumbnails in an

album. They are:

• Name – reorders thumbnails alphabetically according to the
filenames of their associated files.

• File Type – reorders thumbnails according to the file type of
their associated files.

• Size – reorders thumbnails according to the file size of their
associated files.

• Date – reorders thumbnails according to the date their
associated files were last saved on.

• Media Type – reorders thumbnails according to the media type
of their associated files.

• Subject – reorders thumbnails according to their subject
properties.
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• Description – reorders thumbnails according to their
description properties.

• Others – opens the Sort dialog box which allows you to choose
more media specific options such as image dimensions and
resolutions.

• User Defined – makes the current sort mode the user defined
mode. As such you can freely move the thumbnails with your
mouse. (You cannot change the position of a thumbnail while in
one of the other sort modes.)

Notes:

• When you choose the Save Sequence command in the Thumbnail
menu, the thumbnails in the album are reordered according to the
current user defined sequence.

• To move multiple thumbnails at the same time, use the Move
command in the Thumbnail menu.(This command is disabled if you
are in a sort mode or there are no thumbnails selected.)

• You can determine the order of thumbnails by checking the “Sort
Thumbnails in Ascending Order” option in the Album dialog box
(see p.25) for ascending order, or leaving it unchecked for
descending order.
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6·4
Exiting Album

When you have finished your Album session, exit by closing the

program window or by choosing the Exit command in the

Album menu. If you have changed the order of images in an

album and wish to retain the new order, choose the “Save

Sequence” command in the Thumbnail menu before you close

Album. (For a large number of albums, use the same command

from the batch manager.)
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7 CD Browser

CD Browser is a program that allows you to preview
and organize photos on any Photo CD disc. (You
cannot use CD Browser if you do not have a CD drive
installed on your system.) These photos can then be
selected and downloaded to your hard disk or opened
in either the Album, Image Editor, or Viewer programs
of ImagePals.
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7·1
Running CD Browser

Before you run CD Browser, you must insert a Photo CD disc

into your CD drive. Once inserted you can open CD Browser in

two ways:

• double-clicking on the CD Browser icon in the ImagePals
program group.

• choosing the CD Browser command from the Pals menu in any
ImagePals program.

7.1.1 The CD Browser window

When you invoke CD Browser you will see:

• Thumbnails of photos within the workspace (the central
portion) of the CD Browser window. (If you replace discs, or
reinsert the original disc, choose the Load Photo CD Disc
command in the File menu to refresh the thumbnails in the
program.)

• A ribbon, below the menu bar, displaying your current CD
Browser settings.

• The status bar, at the bottom, displaying photo information
including the number of total photos, selected photos, and
selected photo file size. (Double-clicking on the status bar opens
the Preferences dialog box, see p.109)
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The CD Browser program window
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7·2
Selecting a photo

In CD Browser you can select individual photos as well as

multiple photos using your mouse in conjunction with the

keyboard. To select an individual photo simply place your

mouse over the desired photo and click the left mouse button,

the photo is encased in a border. To select additional photos,

hold down the Ctrl key each time you click on a new photo.

(Click again to deselect the photo.) To select a range of photos,

click on the first photo in the range and, as you click on the last,

hold down the Shift key. All photos within the range are selected.

Using the File menu, you can also choose the following

commands to select or deselect photos:

• Select All selects all photos.

• Select None deselects selected photos.

• Select Invert selects the unselected photos and deselects the
selected ones. This is useful if you want to exclude a few photos
from a large selection. In such cases select the photos you want
to exclude and then choose the Select Invert command.

Photos 1, 2, and 3 are all selected and appear with a highlighted border
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7·3
Sending photos to Image Editor

Having previewed the photos on your disc, you can then select

the ones you want to work with and open them directly in Image

Editor.

To open a photo in Image Editor:

1. Select the photo or photos you wish to open.

2. Choose the resolution and data type of the photo or photos. This
can be from the appropriate combo boxes in the ribbon or from
the Preferences command in the File menu.

Note: RGB True Color photos with a high resolution take longer to open
than Grayscale, low resolution photos.

3. Click on the Image Editor icon button in the ribbon or choose
“Run Image Editor” from the File menu. Image Editor opens
with each photo displayed in its own image window.

Note: You can also drag-and-drop the photo directly into the Image
Editor workspace.
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7·4
Inserting thumbnails of photos

Although CD’s have great storage capacity, they are relatively

slow when compared to hard disks. As such, whenever you view

or scroll through photos on a CD it takes a little time for the

photos to refresh. To overcome such delays, insert thumbnails of

the photos into the Album program of ImagePals. This allows

you to view the contents of your CD quickly and easily – without

even having to have the CD present. (To access the actual

photos however, you will need to insert the CD into your CD

drive.)

To insert photos into an album:

1. Select the photos you want to place into an album.

2. Choose the resolution and data type of the photo or photos. This
can be from the appropriate combo boxes in the ribbon or from
the Preferences command in the File menu.

3. Click on the Album icon button in the ribbon or choose “Insert
Thumbnails to Album” from the File menu. The Insert
Thumbnails to Album dialog box opens.

4. Select the album you want to place the photos into from the
Album combo box. To place the photos into a new album click
on the New button. This opens the New Album dialog box.
Append any comments, where necessary, into the respective
Subject and Description entry boxes.

5. Click OK. The dialog box closes and the thumbnails are inserted
into the specified album.

Note: You can also drag-and-drop the photo directly into an album.
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7·5
Viewing a photo

At times you may wish to look at an photo in greater detail or

would like to copy the entire photo, or parts of the photo, onto

the clipboard. To do this, simply select the photos you want to

view and:

• choose the Run Viewer command in the View menu,

• click on the Viewer icon button in the ribbon,

• press the Enter key,

• double-click on the photo.

7.5.1 Viewing information

To view information about a photo, first select the photo and

click on the Photo Information button in the ribbon or choose

the Photo Information command in the View menu. The Photo

Information dialog box opens. In this dialog box you can find

information about when the photo was created, if it has been

modified and if there are any existing copyrights. Clicking on the

photo with the right mouse button also displays similar

information. Where applicable, there is also information about

the photo finisher, the person or company who prepared the

photo.

To view information about your disc, click on the Disk

information button in the ribbon or choose the Disc Information

command in the View menu. This displays the serial number of

your disc, when it was created and if it has been modified. (The

Sessions information refers to the number of times your CD has

been written to.)
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7·6
Saving photos

When you insert thumbnails of photos into an album, view them

with the Viewer program, or send them to Image Editor, the

photo itself still remains on disc. As Photo CD photos are read

only, it is not possible to edit and then save these photos back to

disc.

If you wish to edit photos, you must first copy them to your hard

disk. This can be done in several ways using either the CD

Browser, Viewer, Image Editor or Album programs.

To save photos from the CD Browser, Viewer or Image Editor

programs choose the Save As command in the File menu of

either program. This opens the standard Save As dialog box.

From here you can specify a new drive and directory, as well as

the file format and resolution of the saved photo.

In Album use the Copy command in the File menu to copy the

files from CD to a new drive and directory. Using this method,

however, copies the photo in the original multiple resolution

PCD file format. As such the file will occupy more disk space

than any of the other methods described.
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7·7
Customizing CD Browser

To customize CD Browser, choose the Preferences command in

the File menu. The Preferences dialog box opens. In this dialog

box you can select the CD drive, resolution, data type and

background color scheme of CD Browser. Apart from the

background color scheme, all options can be accessed from

corresponding combo boxes in the ribbon.

It is important to remember that resolution and data type have a

direct relationship to how a photo appears in another program.

For example, the higher the resolution and the more colors a

photo contains, the larger the photo, both in dimensions and file

size. In most cases use the smallest resolution – this also makes

transferring the photo to a program much quicker.

Note: Changes made here to the resolution and data type of photos are
also reflected in the CD Browser preferences of the other ImagePals
programs, and vice versa.
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7·8
Exiting CD Browser

When you have finished your session with CD Browser, exit the

program by choosing the Exit command in the File menu. It is

not necessary to remove the disc. If you leave the disc in, the

next time you run CD Browser the contents of the disc will be

automatically displayed in the workspace.
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8 Viewer

Viewer is a unique program that allows you to quickly
“call up” image and graphics files, displaying them in
individual Viewer windows. This allows you to
preview and compare files as well as perform basic
editing functions, such as crop and copy, without
having to first invoke the program the file was
originally created in.
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8·1
Running Viewer

Viewer can be invoked in a number of ways:

• double-clicking on the Viewer icon in the ImagePals program
group. (The Open dialog box appears, allowing you to select a
file to view.)

• choosing the Viewer command from the Pals menu in any
ImagePals program. (The Open dialog box appears, allowing
you to select a file to view.)

• double-clicking on the thumbnail (or filename) of any image or
graphics file in Album .

• dragging a thumbnail and dropping it onto the Viewer program
icon in the Album toolbox.

• choosing the Run Viewer command in the CD Browser View
menu. (The selected photos are displayed.)

• choosing the File command in the View menu of Album. (The
contents of the file are displayed.)
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8.1.1 The Viewer window

When you invoke Viewer you will see:

• An image within the workspace (the central portion) of the
Viewer window.

• The status bar, at the bottom, displaying relevant file
information. (Double-clicking on the status bar opens the
Viewer preferences dialog box, see p.119.) Two buttons are also
included on the status bar: the first button (from the left) is the
switch button which allows you to switch between multiple
Viewer windows. The second button is the drag-and-drop
button. To drop the Viewer file into another program, first click
on this button and drag your mouse. Releasing the mouse drops
the image into the destination program.

The Viewer program window
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8·2
Editing a file in Viewer

Although Viewer is primarily geared towards providing a quick

view of an image or graphics file, you can still perform basic

editing functions such as crop and copy. Cropping discards

areas of an image that are not necessary to your work. This is

particularly useful if you want to isolate parts of an image or

decrease file size. To perform more extensive editing, choose the

Run Image Editor command in the File menu. This invokes

Image Editor program with the file open in the workspace.

Note: If you have assigned another editing program from the Viewer
dialog box (see p.119), chose the Run Other Editor command. This is
useful if you want to edit a graphics file in a drawing program.
Alternately you can click on the drag-and-drop button in the status
bar and then drag your mouse and drop the file into the program
you want it to open in.

To crop an image, drag you mouse over the area you want to

crop, (the area is immediately deselected when you create

another area, click the right mouse button or choose the Select

None command in the Edit menu), and choose “Crop” from the

Edit menu. The areas outside the selection area are discarded.

If you have made a mistake or wish to undo the command,

choose the Reopen command in the File menu. This restores the

image to its last saved version. To save any changes, choose the

Save As command in the File menu.

Note: After cropping an image, the drag-and-drop button is disabled.

8.2.1 Using the Copy commands

There are two copy commands in the Edit menu of a Viewer

window: Copy and Copy Filename. Copy duplicates the entire

image or selected part, and places it onto the clipboard. Copy

Filename places the full pathname of the currently displayed

image onto the clipboard.
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8·3
Changing the view in Viewer

When it comes to controlling the view of an image, all the

necessary commands can be found in the View menu of a

Viewer window. If you are familiar with the viewing commands

in ImagePals Image Editor you should have no problem here as

these commands are identical in nature.

Actual view

Choose the Actual View command when you want to display an

image with each image pixel shown by one screen pixel. This is

the normal (1×) view of an image. Graphics are displayed at the

size determined by your current display driver’s resolution.

Zoom in and out

Each Viewer window allows you to zoom in and out on an

image. Zoom In enlarges the view of the image, Zoom Out

reduces the view of the image. You can zoom in one step

increments from ⅛× to 8× the original size.

The global viewer

When the whole of an image cannot be displayed in its window,

you would normally have to use the scroll bars to locate hidden

areas. The global viewer of Viewer is a better method that allows

you to locate these areas quickly and easily by providing a

thumbnail view of the entire image. This thumbnail image

contains a floating frame that can be moved independently

around the viewer when viewing at normal (1x) magnification.

Moving the frame automatically repositions the current view of

the active image. To access the global viewer, click on the global

viewer box at the intersection of the scroll bars.
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Full screen

The Full Screen command displays an image at the current

zoom level using the whole screen as a backdrop. (The program

window, menu bar and status bar are all hidden.) Most of the

functions and shortcut keys remain available. Scroll bars appear

when the image is too large to be completely displayed. To

return to normal screen mode press the Esc key.

Fit in window

When using any of the zoom commands the image window does

not change to fit the new image size. As such there may be times

when the whole of an image cannot be displayed in its window

and scroll bars appear along the window border. If you wish to

display the image within its window without scroll bars, choose

a Fit in Window zoom command.

Note: The maximum and minimum zoom level possible is determined by
the original size of the image.

8.3.1 Viewing Information

When you display the contents of a file in a Viewer window, you

can access information about that file at any time by choosing

the Information command in the View menu. This opens the

Information dialog box which displays attribute information

such as data type, width and height, resolution, and size of the

image. There is also a section on file information including the

filename, format, compression, whether the file can be

previewed, space occupied on disk and if the file is readable.

Note: For some file formats the above information may vary.
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8·4
Managing Viewer windows

Viewer is a quick and efficient way to view image and graphics

files, as such you can be easily over-run by Viewer windows. To

control these windows, use the batch commands in the File

menu: Close All, Minimize All and Restore All. Choosing “Close

All” closes all Viewer windows from the screen. If you have been

performing crop operations, you will be asked to save the

changes made. Select No to discard changes; Yes to save the

changes. Choosing “Minimize All” minimizes all Viewer

windows and the “Restore All” command restores minimized

Viewer icons.

8.4.1 Positioning Viewer windows

One of the real advantages of Viewer is that you can open

multiple Viewer windows to compare different files. This is

particularly useful in the Album program of ImagePals where

you may find the current thumbnails too small to adequately

view or differentiate between images.

All the commands to control the positioning of Viewer windows

can be found in the View menu. Each command is described

below:

Place Viewers on Top

Choosing this command brings all Viewer windows and

minimized Viewer icons to the top, obscuring any programs that

may be currently open. The last Viewer window to be brought to

the front is the active window. To make an individual window

active, you can click on its title bar or click on the switch button

on the left of the status bar. This displays a list of all Viewer

windows in the workspace, choosing one makes it active.
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Cascade and Tile Viewers

The Cascade and Tile Viewers commands arrange Viewer

windows within the confines of your screen. Cascade places

each window below and to the right of the previous. Tile resizes

all viewers to fill the screen. Any minimized Viewers icons are

also brought to the front.

Always on Top

Choosing the Always on Top command ensures that all open

Viewer windows and minimized Viewer icons appear at the

front of other programs. This is useful if you have other

programs running at the same time and do not want to

inadvertently change the active window. If you want to use

another program first uncheck this command.
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8·5
Customizing Viewer

Each Viewer window has similar Preferences commands as

those mentioned in Album, i.e. Photo CD, Display, Memory and

File Formats. The only unique command is Viewer. Choosing

this command opens the Viewer dialog box allowing you to

determine the type of format images take when placed onto the

clipboard, i.e. DIB (Device Independent Bitmap), DDB (Device

Dependent Bitmap), and WMF (Windows MetaFile). (For more

information on file formats refer to the introductory guide.)

You can also select another editing program which can be

accessed from the Run Other Editor command in the File menu

of each Viewer window. If you work with graphics, then assign

your graphics editing program here. The next time you view a

graphics file and wish to perform additional editing, choose

“Run Other Editor”. This opens the file in the specified editing

program.

Note: The Viewer preferences options only apply to the image in each
individual Viewer window. This allows you to select different
options for different images and purposes.
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8·6
Exiting a Viewer window

When you have finished using a Viewer window, exit by closing

the program window or by choosing the Exit command in the

File menu. When exiting a Viewer window, you will be asked to

save the changes to files you may have cropped. Select YES to

save the changes, NO to discard them. If you have many open

Viewer windows, choose the Close All command in either of the

Viewer’s File menus. This closes all Viewer windows in the

workspace.
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